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Introduction
Welcome to Microsoft® Expression® Media 2, your comprehensive solution for 
cataloging, organizing, modifying, and distributing your digital media files. Wherever 
your files are stored and whomever you collaborate with, Expression Media enriches the 
way you organize, find, and share your digital media on your computer, offline, or on 
the web.

What’s new in Expression Media 2?
Hierarchical keywords  •	  With the new Hierarchical Keywords display in the 
Organize panel, you can create and view hierarchies of keywords for your media 
files. For example, instead of tagging a photograph “dogs,” you can create a 
keyword hierarchy that specifies animals, mammals, and even specific breeds. The 
keyword finder gives you many options for clearly and accurately categorizing your 
media files.

Multi-monitor Light Table•	    You can increase your productivity by having the Light 
Table open on one monitor while your catalog and tools are open on another. 
There’s no longer a need to switch back and forth between views.

Microsoft Virtual Earth•	 TM positioning   Using Virtual Earth technology, you can 
locate the origin of any photograph that includes GPS information. Expression 
Media displays the location on a virtual world map.

Improved sorting•	    Each panel contains new menus in annotation fields that 
include options for sorting images using either a union or an intersection of 
keywords.

For a complete list of new features, see the “What’s new” topic in Expression Media 
Help (on the Help menu).



Contents

Getting started	 1

Understanding Expression Media 2	 4

Quick start: The basics	 9

Quick start: New features	 24

Appendix	 29



Getting started
You can install Expression Media 2 from the Microsoft 
Expression Media 2 CD. Information in this section will help 
you get started.

In this section
Before you begin•	 	

Installation instructions•	 	
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Before you begin
System requirements   Check the package to make sure that your computer meets the 
minimum system requirements. 

Product key   Find your 25-character product key on the disc holder. Enter the key 
when prompted.

Internet connection   If you plan to install additional components or get more 
information about Expression Media, make sure that you have a working Internet 
connection.
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Installation instructions
1.	 Insert the Expression Media CD into your computer’s optical drive.

2.	 Double-click the .dmg file.

3.	 Follow the on-screen instructions to install Expression Media.

Troubleshooting your installation

If you experience problems while installing Expression Media, go to the Microsoft 
Expression site (www.microsoft.com/expression) or the Microsoft Support Site  
(www.microsoft.com/support) for more information or help.



Understanding Expression 
Media 2
Expression Media 2 features a comprehensive, streamlined 
workspace that provides all the tools and views that you need 
to clearly identify, organize, and work with your digital media.

In this section
Who uses Expression Media 2?•	 	

How Expression Media works with your files•	 	

The main interface•	 	
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Who uses Expression Media 2?
Expression Media 2 provides solutions for anyone who works extensively with any sort 
of digital content, including digital media files, fonts, Adobe PDFs, and documents. In 
short, if you are interested in creating high-quality, well-organized, and specifically-
annotated catalogs of your digital files, as well as modifying, repurposing, sharing, and 
archiving those files, then you can use Expression Media.
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How Expression Media works with your files
Expression Media uses catalogs to organize your media files. Expression Media catalogs 
are proprietary files that, when opened, display thumbnail images of your files, along 
with file names, file locations, and metadata information. Catalogs do not actually 
store your original files. Instead, they store only information about your original 
files, including paths, thumbnails, and annotations. Because the catalogs store file 
information, including thumbnail images, you can always open the catalogs to display 
and sort your media files, even when your original media files are not available.
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1	 Toolbar
Enable various viewing 
and exporting modes 
such as Slide Show 
mode and the Image 
Editor from the buttons 
on this toolbar.

2	 Views
Choose any one of 
three ways to view 
the media files in your 
catalog.

3	A nnotation 
Panels
View and add 
metadata to your 
files in this panel. The 
Info and Organize 
panels both contain 
metadata. Use the 
Info panel to view and 
add metadata, such as 
exposure and source 
information, about 
each individual file 
and use the Organize 
panel to sort your files 
by metadata criteria, 
or any other criteria 
that you specify. 

4	 HIERARCHICAL 
Keywords list
Create keywords with 
varying hierarchical 
layers to specifically 
identify each file.

5	 Catalog Folders 
Panel
Manage the location 
of all your catalog files, 
and quickly sort them 
for viewing or import 
them from watched 
folders.

The main interface
After you create a catalog, Expression Media presents a broad, customizable view of 
your imported files, their accompanying metadata, and the hierarchy of folders in your 
catalog. In this interface, you can also play movies, rearrange and rename your files, 
and select specific files to modify or to export in a variety of formats.

For information about how to use other workspace elements such as the Light Table 
and the Slide Show, see the next section, “Quick start: The basics.”
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Quick start: The basics
If you are new to Expression Media, you can follow these 
tutorials to get a good overview of the basic workflow.

In this section
Import and catalog your files•	 	

View metadata in your files•	 	

Organize your media•	 	

View your media in the Light Table•	 	

Edit your images•	 	

Create a Slide Show•	 	

Export your images as an HTML gallery•	 	
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Import and catalog your files
After you install Expression Media 2, you must create a catalog containing the media 
that you want to organize. 

1.	 Start Expression Media. 

2.	 If this is the first time you have opened the program, you may be prompted to 
select a method of creating a catalog. If you get this prompt, click Import Items 
from Files/Folders. If you do not see this prompt, then, on the File menu, point 
to Import Items and click From Files/Folders. Alternately, you can close the initial 
dialog box and drag your digital media directly into the catalog window. 

3.	 Browse to the location where you have stored your images, select the folder that 
contains the images (or select individual images) and click Import.

4.	 If you don’t see all of your images, then click the Thumbnail tab.

Additional information
You can create several catalogs in order to store different file types, images from 
different authors, or for whatever reason you think will help you organize your files. To 
create more catalogs, repeat steps 2 through 4.
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	I mport Items command
Use this command to populate your 
catalog. Note that you can import 
from various file sources, including 
the Internet.

	 The views
After you create the catalog, you can 
view your media files either in List 
view (top), Thumbnail view (center), 
or in Media view (bottom).
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View metadata in your files
Use the Info panel to view any EXIF metadata and IPTC standard annotations that are 
embedded in a single image. You can also add metadata to the file from this panel. 

1.	 In your catalog, click the Thumbnail tab to switch to the Thumbnail view. 

2.	 In the Thumbnail view, select a file. 

3. 	 Click the Info button. In the Media Info section, note the embedded data for the 
file, such as File Type, Dimensions, Resolution, and so on. Most of the information 
in the Media Info section cannot be changed. 

4.	 Click another file to view more data. Note that you cannot click more than a single 
file to view data. The Info panel is designed to view the metadata of one file at a 
time.

5.	 You can add metadata in the Annotations section. Scroll to a keyword field in the 
Annotations section and double-click the box next to a keyword name. 

6. 	 Type a keyword in the box.

Note: Any keyword that you add to a media file is associated with that file in the 
current catalog only. If you want the keyword to be embedded with the image, you 
must use the Sync Annotations command. See the Expression Media Help for more 
information.
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	th e info panel
Use this panel to view metadata 
associated with your media file. You 
can also add metadata fields and 
keywords. Note the “World travel” 
annotation above.

	A nnotated image
Most images taken by a digital 
camera have EXIF metadata 
embedded, but you can add any 
number of annotations to an image 
and you can set the annotation to 
appear in the view.
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Organize your media
Expression Media enables you to organize your media using practically any criteria that 
you want. 

1.	 In your catalog, click the Thumbnail tab to switch to the Thumbnail view. 

2.	 In the Thumbnail view, select a group of files that you want to categorize and drag 
the group to the keyword. 

3. 	 If you can’t see the Organize panel, click the Organize button.

4.	 In the Catalog Fields section, scroll to the Keywords catalog field and expand it.

5.	 On the keyword menu, click Add Keywords.

6. 	 In the Add Keywords dialog box, type a keyword term in the Term box and then 
select Apply term to selected items and click OK. 

7.	 Your specified term is now assigned to the images that you selected. To sort your 
images according to this term, click the empty circle next to the keyword. The 
Thumbnail view now displays only the files that have that keyword. You can also 
assign that keyword to an image by dragging the image from a view onto the 
keyword.
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	 annotations field
Expression Media uses the industry-
standard annotation fields and also 
allows you to create custom fields. 

	 sorted files in thumbnail view
When you click your annotation term, 
Expression Media sorts your files according 
to that annotation. You can sort using 
multiple terms.
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View your media in the Light Table
The Light Table provides an ideal viewing environment for either isolating an image 
at full-screen view or seeing your images on a large grid. You can also evaluate each 
image for over/underexposure and check the image color levels. If you work with 
multiple monitors, you can drag the Light Table display to one monitor and keep your 
catalog images visible on another for quick access

1.	 In the Thumbnail view, select up to six images (the Light Table can display a 
maximum of six images). 

2.	 On the View menu, click Light Table. 

3. 	 Note the shortcuts on the information screen and then press ENTER to exit the 
screen. If your image is not at full screen, press F11 (see the “Appendix” section for 
more keyboard shortcuts for working in the Light Table).

4.	 Press H to view the Histogram, which shows you the levels of red, green, and blue 
in your images.

5.	 Press W to view the exposure warnings, which show you all the areas of the image 
that are over or underexposed, in red and blue, respectively.

6. 	 Right-click or CTRL + click the image and, in the shortcut menu, point to Panels and 
choose a number. This indicates how many images will display at once in the Light 
Table.

7.	 When you are done, press ESC.
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	 Full-screen view
The full-screen view in the Light Table 
gives you a very clear and expansive 
look at your image. In this image, you 
see the possibly underexposed areas in 
blue as well as the Histogram showing 
the amount of red, green, and blue in 
the image.

	 View multiple panels
If you choose to view multiple images 
at once, each one will display the 
exposure warnings and Histogram. 
You can easily replace any panel with 
another image from your catalog.
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Edit your images
In Expression Media, you can apply a variety of adjustments to your photographs using 
the Image Editor. You can perform basic adjustments such as cropping and adjusting 
brightness and contrast, or you can perform more artistic adjustments such as creating 
a duotone or a photo negative.

1.	 In your catalog, click the Thumbnail tab to switch to the Thumbnail view. 

2.	 In the Thumbnail view, select a file that you want to edit. 

3. 	 On the Window menu, click Image Editor.

4.	 In the Image Editor dialog box, click Convert to Duotone.

5.	 Select new colors for your duotone image and adjust the Brightness and Contrast 
for your colors. Click Preview to see your changes in the Media view.

6. 	 When you are done, click OK. You can apply more effects if you want, or you can 
exit the Image Editor.

Additional information

You can save each version of your edits so that you can later retrieve any previous state 
of the image. See Expression Media Help for more information.
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	I mage editor
Select from many  
high-quality options for 
enhancing or repairing 
your image.

	c reate effects
Adjust your effects in the effect window 
using the available options. You can choose 
to preview the image in the Media view as 
you adjust the parameters.
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Create a Slide Show
Use the Slide Show feature in Expression Media to progressively display a series of your 
images and play back your sound and movie files.

1.	 On the Make menu, click Run Slide Show.

2.	 The slide show begins immediately. If it doesn’t begin, click the Run/Pause button 
on the Slide Show controller. If you don’t see the Slide Show controller, press 
ENTER. 

3. 	 As the slide show continues, you can change the type of transition between all 
of the images. To do this on the Set Transition menu, click a new transition. Each 
image that follows will use the transition that you select.

4.	 When you are done, press ESC.
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	 slideshow controller
Lists the files that will be displayed 
in the slide show and gives you 
complete control over global or 
file-specific playback parameters. 

	 Play slide show
If you want to view your slide show outside 
of Expression Media, you can export it as a 
movie.
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Export your images as an HTML Gallery
You can quickly create a gallery of your catalog that you can post to your website.

1.	 On the Make menu, click HTML Gallery. 

2.	 Choose an appearance from the Theme menu. Note the theme previews 
underneath the menu. 

3. 	 When you see a theme you like, click Make.

4.	 Choose a location for the files and click OK.

5.	 When Expression Media finishes creating the gallery, the gallery opens in your 
default browser for preview. You can then use a secure FTP application to upload 
the gallery files to your website.

Additional information

You can also save your gallery using a specially-designed, dynamic SilverlightTM 
template.
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	 Html gallery
Expression Media creates all the code necessary for you to create a gallery home page 
with thumbnails. Click any one of the thumbnails to open an image and use the links to 
navigate through the gallery.



Quick start: New features
Expression Media introduces new features that both improve 
overall performance and enhance your ability to sort and 
share your files. This section describes some of these new 
features.

In this section
Create hierarchical keywords•	 	

Locate your image on a map  •	
	 using GPS coordinates	
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1	 Create Hierarchy
Classify your images according 
to any criteria. Use the 
Hierarchical Keywords dialog 
box to type a keyword, and 
assign it as either a top‑level 
keyword, or, as in this case, 
assign it as a sub-level keyword.

2	 sort by keyword
Once you create the sub-level 
keyword and associate your 
images with that keyword, you 
can click the circle next to the 
number of images. Expression 
Media will display only those 
images in the sub‑category you 
selected.

Create hierarchical keywords    
In the Hierarchical Keywords section of the Organize panel, you can create multiple-
level hierarchies of your existing keywords, or add new keywords that you can 
subsequently place in hierarchies. You can then drag images from the catalog to those 
keywords in order to assign the keywords to the images.

Keyword hierarchies are valuable for specific classification and organization of your 
media files. They enable you to create very detailed categories in which to store your 
images.
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1	v erify GPS information
Your image contains GPS 
information if, in the Info panel, 
you see coordinates listed in the 
Latitude and Longitude fields.

2	 Plot your image
On the Window menu, click 
Virtual Earth. Then, in the 
catalog view, click your image. 
Expression Media reads the 
GPS coordinates and places a 
pushpin icon on the map in a 
location that corresponds to 
the coordinates.

Locate your image on a map using GPS coordinates
If you have an active Internet connection, Expression Media combines Virtual Earth and 
the GPS information in your photograph to plot the location of your photographs on a 
world map.
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Appendix
For more detailed information about the features in 
Expression Media or how to accomplish a specific task, see 
Help. You can access the Help by clicking Expression Media 
Help on the Help menu, or by pressing F1.

In this section
Keyboard shortcuts•	 	

Learning and community resources•	 	
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Keyboard shortcuts for Expression Media 2
Show or hide view options +J

General preferences +COMMA

Media rendering preferences +SHIFT+COMMA

Vocabulary editor OPTION+ + COMMA

Assign star rating CTRL+0–5

Assign color label 1–9; press 0 to remove

Rebuild item +B

Sync annotations OPTION+ +B

Clear annotations SHIFT+ +B
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Light Table keyboard shortcuts for Expression Media 2

Launch Light Table +/

Move active cell to first or last 
visible catalog item HOME or END

Add/remove panel to Light Table CTRL+EQUAL SIGN or 
CTRL+MINUS SIGN

Previous/next group of panel 
images

arrow keys or PAGE UP and  
PAGE DOWN

Slide Show keyboard shortcuts for Expression Media 2

Launch slide show +R

Start/stop slide show SPACEBAR

Move to next video frame  
during pause

CTRL+RIGHT ARROW or DOWN 
ARROW

Move to previous video frame 
during pause

CTRL+LEFT ARROW or  
UP ARROW
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Learning and community resources	
Apart from the Expression Media Help, the following additional content and resources 
are available:

Expression community website •	 (training, tutorials, videos, and webcasts)  
	 http://expression.microsoft.com

Expression Media discussion forums•	  
	 http://forums.expression.microsoft.com 

Expression Media solution center•	  
	 http://support.microsoft.com/ph/12600



www.microsoft.com/expression/macoffice


